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Lesson 1: Creating a Captivate Plan 
 

Purpose 
In this lesson, you will learn how to create a plan of what you want to simulate in a movie in Macromedia 
Captivate.  For this workshop, we will be learning how to use the Solver Add-in feature of Microsoft 
Excel and creating a plan for this feature. 
 
Prerequisites 
You should have successfully completed Lesson 1: Introduction to Excel from the Workshops on 
Microsoft Excel, before attempting this lesson. 
 

Part 1: Creating a Plan 
 

Solver Add-in Feature 
Before creating a Captivate simulation, you first will need to know of what you would like to simulate 
(i.e. what program and what specific feature).  You must create a plan of what you wish to show in your 
simulation, as this will influence the content of your simulation and specifically the information in your 
text captions.  For this workshop, we will be creating a simulation of the Solver Add-in feature, a feature 
often used for equation solving and optimization purposes, in Microsoft Excel through the 
implementation of a summation formula.  For future reference, we recommend that you become familiar 
with whatever program feature you want to simulate before using Macromedia Captivate.  This entire 
lesson will be conducted solely in Microsoft Excel. 
1. Open Microsoft Excel.  It may be listed as the following from the Start menu: Start / Programs / 

Microsoft Office / Microsoft Excel 2003. 
2. Access the Solver Add-in through the following:  Tools / Add-ins. 
3. When the Add-ins window pops up, there will be a list entitled “Add-ins available.”  Check the option 

Solver Add-in and click OK.  To check to see if your option has been added, click on the Tools 
toolbar and see if the option “Solver…” is under this menu. 

4. Add five numbers in the first five vertical cells under column A.  We used and recommend that you 
use the following for this workshop: 1 (A1), 2 (A2), 3 (A3), 4 (A4), 5 (A5). 

5. Insert the following formula into the cell A7: =SUM(A1:A5), with A1:A5 being the range of five 
numbers that we just typed.  Press the “Enter” button.  This formula uses the summation formula 
function and adds up all of the numbers in a given range. 

6. Access the Solver Add-in feature through the following: Tools / Solver…  The window entitled 
“Solver Parameters” should appear.  We will use the Solver Add-in to set constraints and 
specifications to reach or achieve a certain solution. 

7. For the “Set Target Cell” option, select the cell A7, which should show up as the following: $A$7 
(with a dollar sign [$] in between each character).  Instead of selecting the cell, you may also type it 
directly in the option box as the following: $A$7 (with the dollar signs included).  This is the cell that 
contains the formula for which we will be setting constraints and specifications. 

8. For the “Equal To” option, select “Value of,” and type the number 50. This will modify the data so 
that the sum equals 50. 

9. Under the “By Changing Cells” option, select the 5 cells containing the five numbers you typed 
(A1:A5).  It should show up as the following: $A$1:$A$5 

10. Under the “Subject to the Constraints” option is where you will add the constraints and specifications 
that you want the Solver Add-in to obey.  For this workshop, we will want our data to be integers 
(whole numbers) and have no individual datum be smaller than 1 or larger than 20. 
a. To add your first constraint, click Add.  A window entitled “Add Constraint” will appear.  Under 

the “Cell Reference” option, select the cells that you wish to modify: A1 through A5.  It should 
show up as the following: $A$1:$A$5 



b. Next to the “Cell Reference” option is a small drop-down menu.  Select the int option from the 
drop-down menu.  Click Add.  This will ensure that all of our data are strictly integers. 

c. Select cells A1 to A5 again for the option “Cell Reference,” select the >= operation, and type the 
number 1 under the “Constraint” option.  Click Add.  This will ensure that none of our data is 
smaller than 1. 

d. Select cells A1 to A5 again for the option “Cell Reference,” select the <= operation, and type the 
number 20 under the “Constraint” option.  This will ensure that none of our data is larger than 20. 

e. Since this is our last constraint and we do not want to add any more, click OK. 
11. All of your constraints should be listed under the “Subject to the Constraints” option in the “Solver 

Parameters” window.  Once all of your specifications have been set, click on Solve. 
12. A new window entitled “Solver Results” should appear.  If the process was successful, the following 

will be listed: “Solver found a solution.  All constraints and optimality conditions are satisfied.” 
13. If you look at your data (cells A1 through A5 and A7), they should have changed to conform to your 

constraints and specifications.  The numbers in cells A1 through A5 should all be integers and not be 
smaller than 1 or larger than 20.  Cell A7 should also have the number 50, which is the sum that you 
specified for your Solver Add-in.  For instance, we received the following: 8 (A1), 9 (A2), 10 (A3), 
11 (A4), 12 (A5), 50 (A7). 

14. Select the option “Keep Solver Solution” and click OK.  This will allow you to keep your results 
yielded from the Solver Add-in.  If you wish to keep your original numbers, you would select the 
option “Restore Original Values” and click OK. 

15. Create a new spreadsheet document in Microsoft Excel.  You will use this new document to repeat 
the process of the Solver Add-in Feature for your simulation in Lesson 2.   



 
Lesson 2: Learning about Captivate 

 
Purpose 
In this lesson, you will learn how to use Macromedia Captivate by creating a simulation tutorial of the 
Solver Add-in feature in Microsoft Excel. 
 
Prerequisites 
You should have successfully completed Lesson 1: Creating a Captivate Plan from the Workshops on 
Captivate, before attempting this lesson. 
 
Example 
To see an example of what your final simulation may resemble, view the accompanying movie: 
Workshops on Captivate Simulation Solver Add-in Example.htm.  This will help you review the Solver 
Add-in feature in Microsoft Excel and show you many of the features that your simulation should have. 
 

Part 1: Introduction to Captivate 
 
Opening Captivate 
1. Open the program Macromedia Captivate.  The program may be accessible as a desktop icon shortcut 

or listed under the Start menu.  If it listed in the Start Menu, it may be listed as the following: Start / 
Programs / Macromedia / Macromedia Captivate. 

 
Part 2: Captivate Basics 

 
Recording/Creating a New Movie Project 
1. Upon opening Captivate, you can click on the link “Record or create a new movie” under the centered 

section “Record new movie on the default window.”  If you are unable to access the default window, 
you can record or create a new movie through the File menu: File / Record or create a new movie. 

2. A window entitled “New movie options” should appear. 
3. Select the “Custom size” option and click OK. 
4. Two windows will appear: a large red rectangular outline and a smaller gray window labeled “Record 

specific size.”  The red outline is the recording window; anything inside this bordered area will be 
recorded in your movie.  The smaller gray window lists recording options. 

5. Click on the drop-down menu entitled “Optionally, select a window you’d like to record.”  When you 
click on it, all of your currently opened programs, excluding the Captivate program you are currently 
using, will be listed.  Click on the Microsoft Excel option. 

6. Click on the button “Snap window to fit inside the red recording area.”  Generally, the window you 
select to record will not automatically fit the resolution size you want or originally have; clicking this 
button will correct this problem. 
a. If you move the Excel window or the red recording window at any time and need to restore it to 

its original state, click on the button “Snap window to fit inside the red recording area” again. 
 
Adjusting the Recording Movie Options 
1. Click on the “Options…” button on the gray menu.  The “Recording options” window will appear. 
2. Under the “Recording Options” tab, there is an option entitled “Enable auto recording.”  Check this 

box.  We will be using this for our simulation.  Under the “Language” option, select “English.”  
Under the “Recording defaults,” select “captivate blue.”  There are various options under each 
category, and for this workshop we will mainly use the default settings. 



3. Under the “Recording Options” tab, there is an option entitled “Recording mode.”  The recording 
mode allows us to choose what style of movie we would like to make.  For this workshop, select 
“Demonstration.” 

4. Under the “Recording Options” tab, there are two more categories entitled “Sound” and “Options.”   
a. Make sure that no options under the “Sound” category are selected.  We do not want any sound 

recorded in the movie.  If you would like to have your keyboard strokes recorded in a later movie 
project, you would modify the options in the “Sound” category. 

b. Under the “Options” category, make sure that the only option that is selected is “Move new 
windows inside recording area.” 

5. Click on the “Change Recording Keys” tab.  Pay special attention to these options, as you will use 
these keys later during the recording process. 

6. Under the “Change Recording Keys” tab, make sure that the default options are selected.  For the “To 
stop recording keys option,” select “End”.  For the “To manually capture a screenshot press” option, 
select “Print Screen”.  For the “To start full motion recording press” option, select “F9”.  For the “To 
stop full motion recording press” option, select “F10”. 
a. Capturing a screenshot is a valuable feature of Captivate.  During the recording process, if you 

want to take a screenshot, press “Print Screen”. 
b. Press “F9” before typing in cells, and press “F10” when you are finished typing in cells.  Pressing 

these buttons enable the Full Motion Recording feature of Captivate.  In some situations, 
Captivate will not record certain motions or movement that it deems unnecessary (such as typing 
in numbers).  In order to force Captivate to record a specific motion or movement that you want 
to include in your movie, you would start the Full Motion Recording (by pressing “F9”) and stop 
it (by pressing “F10”) when you are finished with that specific motion or movement.  If you do 
not do this, the typing process will not show up in your movie. 

7. Once you are finished adjusting and learning about the options, click OK. 
 
Recording the Simulation 
1. If necessary, reread the previous Lesson 1: Creating a Captivate Plan lesson in order to refresh your 

memory on what you will need to do for your simulation. 
2. Before starting the recording process, try to exit out of any unnecessary windows that you will not be 

using while recording.  This minimizes difficulty and confusion during the recording process. 
3. When you are recording, simply act as you would if you were not recording.  In Demonstration mode, 

the trail of the mouse will automatically be recorded as animation.  Also, be aware that when you use 
scrollbars or highlight many things, animation will occur. 

4. When you are recording, do not forget to use the Full Motion Recording feature whenever you are 
typing something. 

5. When you are recording, do not be alarmed if the computer monitor and/or cursor starts to flicker or 
function at a slower pace.  This is normal; the computer is adjusting to the recording process. 

6. When you are recording, take your time.  Recording a simulation is a difficult process, and it is 
perfectly fine if you make mistakes and need or want to restart the recording process. 

7. Once you understand the recording process and what you need to simulate, click the “Record” option 
to begin recording.  Once you are done with recording, press “End” to stop recording. 

 
Part 3: Editing the Movie Project 

 
Slide Layouts 
1. Once you have completed recording, the material that you recorded will be converted into a Captivate 

movie project and then presented in slide format. 
2. There are two tabs near the top of the Captivate program window: Storyboard and Edit.  Click on the 

Edit tab.  You should see all your movie slides listed in vertical order, in the layout of a film strip.  In 
order to select a slide, left-click on it. 



3. There is also a horizontal bar window entitled “Timeline to Slide #” (with # being replaced by 
whatever slide is currently selected) that is placed to the right of the Storyboard and Edit tabs.  This is 
the window that holds all of the individual components that make up your slides. 

 
Turning On/Off Mouse Clicking 
When you are creating a movie or simulation that depicts the mouse cursor clicking, the sound of the 
mouse clicking, in addition to the path of your mouse cursor, is automatically inserted into your movie.  
We are able to turn off this clicking, turn on this clicking, or change the sound by accessing each slide.  
The slides that show the mouse cursor and that are the ones that need to be of concern have a mouse icon 
image in the right-hand corner of the slide screenshot in the film strip layout. 
1. Select the slide on which you wish to edit the mouse clicking sound options. 
2. Go to the following on the top toolbar: Slide / Mouse / Properties. 
3. A window entitled “Mouse properties” should appear.  Under the “Options” tab, the one that controls 

the option of mouse clicking is “Mouse click sound.” 
4. To turn on the mouse clicking sounds, select the “Mouse click sound” option. 
5. To turn off the mouse clicking sounds, deselect the “Mouse click sound” option. 
6. To change the mouse clicking sounds, select the “Mouse click sound” option.  Select the sound that 

you wish to use from the accompanying drop-down menu (the two default options listed are “Single 
click” and “Double click”).  If you wish to use a sound that is not already listed in the drop-down 
menu, select the Browse option to select the desired sound file from the appropriate file directory. 

7. Once you are finished with modifying the options, click OK. 
 
Moving a Slide 
1. In order to rearrange the order of your movie by moving a slide, select the slide, drag it to its new 

position on the film strip, and release the mouse to apply the change.  You can determine the position 
of each slide by its order number, which is displayed in the left-hand corner of the slide screenshot in 
the film strip layout. 

 
Moving a Slide Object 
1. In order to rearrange the order of an object in a specific slide, select the slide. 
2. Select the object bar you wish to move from the “Timeline for Slide #” horizontal window and drag it 

to its new position in the timeline.  Release the mouse to apply the change. 
 
Adjust the Timing of a Slide 
1. In order to adjust the timing of a particular slide (by either shortening or lengthening it), select your 

slide. 
2. Under the “Timeline for Slide #” horizontal window, select the last bar in the window, which should 

be labeled as “Slide #” (the # depending upon the current position of the slide). 
3. To shorten or lengthen the timing, move the mouse cursor and hover it over the very end of the bar 

that is labeled “Slide #.” 
4. The end of the bar should have a dotted line that vertically extends to the top, which signifies that it is 

the current maximum time period in the slide (e.g. 4 seconds).   
5. Once your mouse hovers over this area, the mouse cursor should transform from a customary white 

arrow to a double-sided black arrow.  To adjust the timing, hold the left mouse button down and 
either move your cursor to the left (to shorten the timing) or to the right (to lengthen the timing). 

6. To extend the timing of any other component of a slide (besides the timing of the slide itself), such as 
a text caption or an audio clip, you would follow the same above instructions.  The only difference 
would be in Step 2.  Instead of selecting the last bar in the window (“Slide #”), you would select the 
bar in the window that represents the object whose timing you wish to adjust. 

 
Adding a Text Caption 



Adding text captions are very valuable and are often necessary for a simulation.  Because you used the 
“Demonstration” option to record your movie, you will find that Captivate automatically generated 
several text captions throughout your movie.  This often makes your job of creating a simulation easier, as 
many of the simple instructions that you wish the user to follow (such as clicking on certain toolbars) has 
already been created by Captivate.  However, solely using the captions generated by the program is often 
not sufficient, as you will need to add more captions to explain your plan to the user. 
1. To add a text caption, go to the following: Insert / Text Caption. 
2. A window entitled “New Caption” should appear. 
3. Under the “Text Caption” category, there are two horizontal rows of formatting tools.  Play with the 

formatting tools, such as the font, size, and color options in the first row. 
4. Below the second horizontal row of tools, there is a large centered text entry box that has the 

following highlighted sentence: Type Caption Text Here.  Type your text in this box. 
5. Near the bottom of the window, there is a check-box option entitled “Apply Properties to all 

‘Captions’ in the Movie.”  If you wish to have uniform captions throughout the simulation, click this 
box and the formatting properties that you have selected for this caption will automatically be applied 
each time you insert a text caption. 

6. Once you have completed your text caption, click OK. 
7. Your text caption should then appear on your centered slide canvas.  If you wish to move the caption, 

select it and drag it to the desired location.  If you wish to increase the size of the caption box, hover 
the mouse cursor over one of the eight small silver boxes that compose the border of the caption and 
drag it across the screen until it becomes the desired size. 

8. Add text captions throughout your movie project when they are appropriate, in order to adequately 
explain your plan and instructions to the user.  Instead of adding multiple text captions throughout 
your movie, you may also edit several of the text captions that were automatically generated by 
Captivate. 

9. To edit a text caption, double-click on the text caption that is located on the centered slide canvas.  
The corresponding window will appear, and you can modify the options accordingly. 

 
Adding a Title Slide 
Adding a title slide is an important part of any simulation.  For this workshop, we will be adding a text 
animation to our title slide to enhance the appearance of the simulation.  You could also use a text caption 
in place of a text animation.  However, we will be using a text animation for this workshop.  Text 
animations are created in a similar way that text captions are created. 
1. To add a title slide, go to the following: Insert / Blank Slide.  If necessary, move this slide to the 

beginning of the movie.  As it is the title slide, the first slide of the movie, it should be labeled with 
the order number 1. 

2. To add a text animation, go to the following: Insert / Text Animation. 
3. A window entitled “New Text Animation” should appear. 
4. Under the “Text Animation” category, there are two categories: “Preview Box” and “Appearance” 

category. 
5. The “Preview Box” is the large white box to the left of the window that contains the following 

centered black text: Sample Text.  You may preview your text animation in this box before you apply 
it to your movie. 

6. The “Appearance” category is to the right of the window and contains the following options: Effect, 
Text, Change Font, Transparency, and Delay (Frames). 
a. The “Effect” option provides you with a drop-down menu of different animation options.  Select 

the one you wish to apply. 
b. The “Text” option provides you with a small white box with the words “Sample Text” inside of 

it.  Type the title of your simulation in this box.  Depending on the simulation, you may need to 
include more information, such as the name of institution association and the full name of the 
author.  Make sure that the text for the title slide is large (22 to 72 point size) and centered.  If you 



would like to change the specific face, style, size, color, or script of your font, click on “Change 
font…” and select your options.   

c. The “Delay (Frames)” option enables you to apply a delay to your text animation, which makes it 
slower, according to a certain number of animation frames.  For this workshop, we will leave the 
default option, which is 1. 

7. Once you have completed your text animation, click OK. 
8. To edit a text animation, double-click on the text that is located on the centered slide canvas.  The 

corresponding window will appear, and you can modify the options accordingly. 
 
Deleting a Slide or a Slide Component 
1. In order to delete a slide from your movie, select a slide and press the “Delete” key. 
2. In order to delete a specific component of a slide, select the component from the “Timeline for Slide 

#” horizontal bar window and press the “Delete” key. 
 
Saving a Movie Project 
1. Save your current movie project through the File menu: File / Save as (or Save).  Find the proper 

directory in which you wish to save it.  Click OK. 
 
Closing & Opening a Movie Project 
1. Close your current movie project through the File menu: File / Close. 
2. Open your movie project (the one you just closed) through the File menu: File / Open.  Find the 

movie file by searching through the proper directory.  Once you select it, click OK. 
 
Previewing Movie 
1. Preview your movie by selecting the following: File / Preview / Movie. 
 

Part 4: Publishing the Movie Project 
 
Publishing a Movie File 
Once you have completed your editing, it is time to save your project as an actual movie file to watch.   
1. Select the following: File / Publish. 
2. A new window entitled “Publish” will appear.  Select the default option “Flash (SWF)”. 
3. Under the category “Flash (.swf) options,” there are two options: Movie Title and Folder.  Under 

“Movie Title,” type the title of your movie.  Under “Folder,” click Browse to find and select the 
directory and folder in which you want to save your movie. 

4. Under the “Output Options” category, make sure that only the “Export HTML” option is selected.  
This option will allow your movie to be viewed in a webpage browser. 

5. Once you have finished with your option specifications, click “Publish.” 
6. A window entitled “Publish progress” should appear.  Once the publication process is finished, the 

word “Completed” will appear next to a green checkmark under the “Progress” category. 
7. To view your movie, click on the “View output” button. 
 

Part 5: Introduction to Advanced Captivate Topics 
 
Importing/Exporting 
In order to enhance a movie, many individuals use the features of importing and exporting.  Importing is 
the process of bringing in copies of outside slides or objects from other movies or programs and applying 
them to your current movie.  Exporting is the process of taking out copies of slides or objects from your 
current movie and creating different applications with them, such as creating an editable Macromedia 
Flash file.  For this part, you will not import or export anything in Macromedia Captivate; you will simply 
be reading over this section to learn about the options available in Captivate. 



1. In order to import, go to the following: File / Import/Export.  You will see that you have three import 
options: “Import movie captions,” “Import Slides/Objects from other Captivate projects,” and “Import 
Microsoft PowerPoint slides.” 
a. The “Import movie captions” option allows you to take movie text captions from a separate 

Microsoft Word document and apply them to your current movie. 
b. The “Import Slides/Objects from other Captivate projects” option allows you to take slides or 

objects from a separate Captivate movie project and apply them to your current movie. 
c. The “Import Microsoft PowerPoint slides” option allows you to take slides from a separate 

Microsoft PowerPoint project presentation and apply them to your current movie. 
2. In order to export, go to the following: File / Import/Export.  You will see that you have two export 

options: “Export movie captions” and “Export the movie to Flash MX 2004.” 
a. The “Export movie captions” option copies the text captions that you use for your movie and 

saves them in a separate Microsoft Word document.   
b. The “Export the movie to Flash MX 2004” option copies your movie and transforms it into an 

editable Macromedia Flash file that you can edit and enhance with features found in Flash.  In 
order to use this option, you will need to have the program Macromedia Flash MX 2004 installed. 


